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About the Workshop
Synopsis

Improve your use of Google Apps to help facilitate creation and collaboration in your classroom. In
this hands-on workshop, I will share some of the useful tools in Google that you can use to enhance
students’ learning such as Google Drive, Google Docs, Hangouts, and Movenote. I will also provide
you some good practices of using these Google Apps for teaching and learning.

Workshop Objectives
By the end of this workshop, participants should be able to:
1. Understand and experiment the instructional technology tools in Google that support
collaborative learning
2. Consider implementing technologies that support collaborative learning methodologies,
especially student project work
3. Explore, experiment, and evaluate collaborative learning technologies in Google as a group

Session Prerequisites
In order to fully maximize the benefits of this workshop, participants will need to create a Google
account and be comfortable using the Internet.
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Getting Started with Google Apps

Google Apps is a set of web applications provided by Google. It allows the teacher and the students
to create, contribute, and edit a document, work collaboratively on documents, presentations,
spreadsheets, forms, and other files, and interact together in a virtual workspace. Each of these
tools can be used in the classroom to accomplish a different set of objectives.

Creating a Google Account

In order to help us get started with the tools, you need to create a Google account. If you do not
have an existing Gmail account or if you prefer to use your NUSNet account to register, it is
completely fine.
To create a Google account:
1. Open your browser and type in this URL: http://docs.google.com. Please note that this is
not the same as Gmail.

2. Enter required information and then click I accept. Create my account.
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Google Drive

Google Drive is a free service from Google that allows you to store files online and access them
anywhere using the cloud. Google Drive also gives you access to free web-based applications for
creating documents, spreadsheets, presentations, and more without having to email that document
back and forth.

Creating a Document

1. Log-in to your Google account.
2. Click on the Apps icon and then select Google Drive.

3. To create a new document, click Create New, and select the type of document you want to
make.

3. To rename a document, click on the title “Untitled document” or the name you have
provided when you first created it.
4. Alternatively, you can upload existing document from your desktop by clicking Upload.
5. By default, Google docs will convert the file you uploaded to make it editable.
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Inserting Text

If you are familiar with word processing software such as Microsoft Word, you will find working
with text in Google Documents to be a similar experience.
To insert text:
1. Move your mouse to the location where you want text to appear in the document.
2. Click the mouse. The insertion point appears.
3. Type the text that you want to appear.

Editing and Formatting Text

Google Documents offer a variety of text formatting options you can use to modify the look and
feel of your document. These options are located in the Toolbar Shortcut menu.

To change the font style:
1. Select the text you want to modify.
2. Click the Font Style box from the toolbar. A drop-down menu of font styles appears. The
name of each font style has been formatted to look like the style it describes.

3. Select the font style you want to use.
4. The selected text will change to the new font style.
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To change the font size:
1. Select the text you want to modify.
2. Select the font size you want to use.
3. The text will change to the new font size.
To change the text color:
1. Select the text you want to modify.
2. Click the Text color box from the toolbar. A drop-down menu of text colors appears.

3. Select the box of the text color you want to use
4. The text will change to the new color.
To change the text alignment:
1. Select the text you want to align.
2. Click the desired alignment button.

Customizing the style of your document

The use of style is another way to format your document. You can apply a consistent formatting to
your text across your document. You will see 6 different styles in the Formatting toolbar- heading 16 and normal text style.
Headings designate the sections of your document. This will be useful especially when you need to
generate a table of contents.

Applying a heading style to your document

1. Highlight the text you want to change into a heading.
2. Expand the styles drop-down menu from the toolbar.
3. Select a heading from the menu.
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Customizing a heading style

1. Highlight a selection of text with the font size and style that you would like to use for normal
text or a particular heading.
2. Go to the styles toolbar menu, and click the arrow next to Normal text or Heading 1-6.

3. Select Update Heading X to match selection.
4. All of the text in your document with the same text type, such as Heading 1 or Normal text,
will be updated to match the font and font size of your initial selection.

Using Normal text

Normal text is the default text style of your document. If you update the style of normal text from
the styles toolbar menu, the default text style of your document will change accordingly.
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Inserting Images

Adding images to your document can make it more visually appealing. Google Documents uses
Google Search to find and provide images for you to choose from, so it is likely you will find one
that matches your needs. If you have a picture of your own that you want to use, you can upload an
image.
To insert an image:
1. Place the insertion point in the document where you want to insert the image.
2. Click the Insert image button.
3. Choose an image from your computer or from the web. Once your image is added, you can
remove or resize it at any time.
•
•

To remove an image, select it, and press Delete key.
To resize an image, select it and then pull one selection handle. Use a corner handle
to proportionally resize its dimension:

To search for an image:
1. Place the insertion point in the document where you want to insert the image.
2. Click the Insert image button.
3. The Insert image dialog box will appear. Click Search.
4. A search pane will appear inside the dialog box. Select one of the three search options.

5. Type the desired search term, and then click the search button.
6. Review the search results. Select the desired image, and then click Select.
7. The image will appear in the document.
To delete an image:
1. Select the image and press the Backspace or Delete key on your keyboard.
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Adding a Hyperlink

A hyperlink is a link to a web address (or URL). If you want to include a web address in your Google
document, you can format it as a hyperlink for someone to click. The hyperlink will then open the
webpage in a new browser window.
Hyperlinks have two basic parts: the address (URL) of the webpage and the display text. For
example, the address could be http://www.nus.edu.sg and the display text could be NUS. When
you are creating a hyperlink in Google Documents, you will be able to choose both the address and
the display text.
To add a link:
1. Select the text (or an image) where you want the link to be displayed.
2. Click the link icon in the formatting toolbar.

3. Type the URL and click OK. The text you selected will now be a hyperlink.
4. Click the link to view the URL.

Adding a Table

A table is a grid of cells arranged into rows and columns. Tables can be customized and are useful
for various tasks such as presenting text information and numerical data.
To add a table:
1. Place the insertion point at the location where you want to insert a table.
2. Click the Table drop-down menu and hover the mouse over Insert table. A grid of squares
appears.
3. Drag the mouse over the grid of squares to select the number of columns and rows in the
table.

4. Click the mouse, and the table appears in the document. The insertion point will now be in
the top left cell.
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To add a row:
1. Right-click in a row adjacent to the location where you want to add a row, and then select
Insert row above or Insert row below from the menu that appears.
To add a column:
1. Right-click in a column adjacent to the location where you want the new column to appear,
then select Insert column left or Insert column right from the menu that appears.
To delete a row or column:
1. Right-click the mouse in the row or column you want to delete, then select Delete row or
Delete column from the menu that appears.

To delete a table:
1. Right-click anywhere on the table and select Delete table from the menu that appears.

Editing Table Properties

You can make modifications to an existing table by adjusting the table properties like cell
dimensions, alignment, border size, and color.
To modify cell dimensions:
1. Hover over the border line you want to modify. The cursor will change into a double arrow.

2. Release the mouse at the desired location. The cell dimensions will change.
3. You can also enter exact cell dimensions using the Table Properties dialog box. Right-click
the cell you want to modify, then select Table properties... from the menu that appears.

To change the cell background color:
1. Select the cell or cells you want to modify.
2. Right click and select Table properties... from the menu that appears.
3. Click the Cell background color drop-down arrow, and then select the desired color.
4. Click OK.
To modify the border color:
1. Right click anywhere in the table. Select Table properties... from the menu that appears.
2. Click the Table border color drop-down arrow, and then select the desired color.
3. Click OK.
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Generating Table of Contents

Once you have finished writing the content of your document, you can now generate a table of
contents. A table of content lists all of your document’s headings in order at the top of your
document. When you click a heading name in the table, it will jump to that section of the
document.
1. Place your cursor where you would like to insert the table of contents.
2. Go to the Insert menu, and select Table of contents.
3. If you need to move the table of contents, select it as you would select text and either move
it with your cursor or you can cut and paste it to any part of your document.
4. You can continue to add headings to your document or change current headings. However,
if you'd like a change to become part of the table of contents, you need to click first the
table and then the Refresh button.

Sharing a Document

Whenever you share a file from your Google Drive, you can let others view and edit the same file.
While you can share any file stored on your Google Drive, it is important to note that you can only
use the collaboration features for files created within your Drive.
When you share a file with a limited group of people, your collaborators must sign in with a Google
account to view or edit the file. However, when you share with a larger group or make the
file public, your collaborators will not need a Google account to access the file.
To share a file with a limited group of people:
1. Locate the file and then click the Share button.
2. In the People box, type the email addresses of the people you would like to share the file
with. You can also add a message that will be emailed to the people you share the file with.

3. For more control over your files, you can click the drop-down arrow to decide whether
people can edit, comment on, or simply view the file.
• Can edit: Collaborators can add and edit content in your document, or add
comments.
• Can comment: Collaborators can add comments, but they cannot edit the content.
• Can view: People can view your document, but they cannot edit it or add comments.
4. Click Send. Your file will be shared.
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Sharing with a link

You can easily share a file with a larger group of people by providing a link to any file in your Google
Drive. A link is basically a URL or web address for any file you want to share. This can be especially
helpful for files that would be too large to send as an email attachment, like music or video files.
You can also share a file by posting the link to a public webpage. Anyone who clicks the link will be
redirected to the file.
To share a link:
1. Locate and select the file you want to share, and then click the Share button.
2. A dialog box will appear. Click Get shareable link.

3. A link of the file will be copied to your web clipboard. You can then paste the link in an
email message or on the Web to share the file. When you're finished, click Done.
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Accessing the files shared with you

People can also choose to share files with you. These files will appear in your Shared with Me
folder. However, if you would prefer to access a file from your Google Drive without switching to
this view, you can move it. To do this, navigate to your Shared with me folder, hover the mouse
over the desired file, then select Add to My Drive.

Collaborating on a Document

After you share a document, you can work on it with your peers in real time, just as you would if
you were sitting together in a class. Depending on the permissions you grant, other people can
update the document itself or, if it is a text document, use comments beside the document to
discuss or brainstorm about the project.

Editing a document simultaneous with peers

Anyone with edit permission can make direct changes to a document. If your peers can make
changes at the same time as you, you can see the changes happen as they are made. Each person’s
changes are marked by a cursor with a different color.
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Collaborating with peers on a document using comments

You can use the comment feature to explain or clarify important points you found in a document
submitted by your students. The comments appear at the right of the document.
To comment on the document:
1. Select a section of text that you want to comment on.
2. Click Insert > Comment.
1. Type your feedback and click Comment. Your comments will appear on the right side of
your document. You can click a comment to verify which section of text it refers to, or to
contribute to the discussion. You can also edit or delete your own comments.

To resolve a comment and hide it:
1. When you are done with a discussion, select the comment and click Resolve.

Tip: The comment does not go away completely unless the person who initiated the
discussion deletes it. You can see resolved comments by clicking Comments > Show
comment stream. You can then re-open a comment if you think it needs more
discussion.
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Google Forms

Google Forms is a useful tool to help you make a survey, give students a quiz, or collect other
information in an easy, streamlined way. A Google Form is automatically connected to a
spreadsheet with the same title. When you send or share a form, recipients’ responses will
automatically be collected in that spreadsheet.

Creating and sending a Google form
1.
2.
3.
4.

Go to http://docs.google.com/forms.
In the bottom right, click Plus Expand icon.
A new form will automatically open.
You can add any questions you want in the form template.

Adding Contents to a Form

You can add different types of questions to your forms. This includes checkboxes, grid, drop-down
lists with options, multiple choices, paragraph text which allow for long answers, and scale to ask
your invitees to grade something in a scale from 1-5, for instance.
To add a question:
1. Click Add .
2. Next to the question title, choose one of the following question types:
• Short answer
• Paragraph
• Multiple choice
• Checkbox
• Dropdown : People can choose an answer from a menu.
• Linear scale : People can rank something along a scale of numbers.
• Multiple choice grid : People can choose points on a grid.
• Date
• Time
3. Type the possible responses to your question. If you want to prevent respondents from
leaving a question blank, toggle the Required button from Off to On.
Sections can make your form easier to read and complete.
To add a section:
1. Click New Section .
2. Label the new section.
You can also add an image or YouTube video to an existing form.
To add an image or a video:
1. To add an image, click Add Image . To add a video, click add Video .
2. Choose your image or video and click Select.
Note: Images and videos in forms can't be attached to form questions.
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Editing a Form

1. To edit a question, header, or description in your form, click the text you want to change
and make your edits.

To duplicate a question:
1. Click a question and then click Duplicate

.

To duplicate a section:
1. Click a section header.
2. Click More .
3. Click Duplicate section.
To delete a question:
1. Click a question.
2. Click Remove .
To delete a section:
1. Click a section header.
2. Click More .
3. Click Delete section.

Applying Theme to a form

1. Open the form
2. Click the Color palette icon .
3. Choose a color for your form. Or, to add a theme, you can click the Image icon
and add
an existing theme to your form from Google+.
4. Your new theme will automatically be applied and you can continue editing your form.

Creating a custom theme

If you want even more control over how your form looks, you can create your own custom theme.
To create a custom theme:
1. Open the form.
2. In the toolbar, click Change theme.
3. Find one of the existing templates in the panel on the right to use as a starting point and
click Customize under the name of that template.
4. Select a section of the form in the panel on the right to begin editing that section. Some of
the options you can customize include:
• Adding custom images to the header and the page background
• Choosing font, font size, font color, and paragraph alignment for the form text
• Choosing a color for the form and page backgrounds
5. Your changes will automatically be applied and you can continue editing your form by
clicking the Edit questions button in the toolbar.
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Previewing the Form

1. To preview the form, click the eye icon. This will display how the form would look like when
the respondents open it.

Sending Out the Form

When you have completed your form, you can now send it to respondents.
To email a form:
1. Open the form.
2. At the top right side of the form, click the Send button.
3. Add the email addresses you want to send the form to, along with the email subject and
message.
4. Click Send.
To get link to a form:
1. Open the form.
2. At the top right side of the form, click the Send button.
3. At the top of the window, click the Link icon .
4. To copy the link that appears, click Copy and enter Ctrl + C on your keyboard.

Tip:
•

You can also use tinyurl to shorten the URL before sending it participants.
To do this, just simply go to http://tinyurl.com, enter the full address, and
then specify a shortcut name in the alias box.

To share a form on social media:
1. Open the file.
2. At the top right side of the form, click the Send button.
3. Choose any of the Google+, Twitter, or Facebook icons.
4. Follow the instructions to share the form.
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To embed a form on a website or blog
1. Open the form.
2. At the top right side of the form, click the Send button.
3. At the top of the window, click the Embed icon .
4. To copy the HTML that appears, click Copy.
5. Paste the HTML into your website or blog.

Share your form with collaborators

You can work together on a form by sharing the form with your colleagues.
1. Open a form.
2. Click the More icon at the top right side of the screen .
3. Choose Add collaborators.
4. In the text box under Invite people, add the names or email addresses of your colleagues
and choose the level of access you want them to have.
5. Click Done.
Note: When you share a Google form with a collaborator, you give that person full editing access to
the form. They will have the ability to make any changes they want to the form, including a change
to where responses are collected.

Collecting and Viewing Form Responses

By default, the form responses are collected in a spreadsheet. You can access form responses at
any time by opening the spreadsheet from your Documents List.
To view the summary of responses:
1. At the top of the form, click Responses.
2. Click Summary.
To view individual responses:
1. At the top of the form, click Responses.
2. Click Individual.
3. To move between responses, click Previous respondent or Next respondent.
To view responses in a spreadsheet:
1. At the top of the form, click Responses.
2. To view the responses in a spreadsheet, click Spreadsheet

. The spreadsheet will open.

To download responses as a CSV file:
1. At the top of the form, click Responses.
2. Click More > Download responses (.csv).
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Google Hangouts

Google Hangout is an instant messaging and video chat platform. Everyone who has a Gmail or
Google+ account will be able to use this feature. You can have a group chat with your students up
to 100 users. This feature is good for exchanging ideas on projects or assignments. The video call
feature allows 10 people to participate. You can think about it as student consultation on
brainstorming on a project assignment. All discussions can be archived for future use.

Setting Video Calls

You can access your video call settings at any time by clicking the gear icon at the top right of the
video call window.
Mute/unmute
microphone

Bandwidth
setting

Invite
Turn on/off web
participants
camera

Leave call

Settings

The settings page helps confirm that your computer is set up and ready to use.
•
•

Bandwidth setting: If you’re experiencing issues with the video or sound quality of your
video call, please try adjusting your bandwidth setting.
Hangouts in HD: If you have the right equipment, you can send and receive 720p HD video
through Hangouts. Learn more about HD Hangouts.

Joining a Hangout

1. Go to http://plus.google.com.
2. Sign in using your Gmail username and password.
3. On the top right corner of the Google+ home screen you will see the account name. Next to
the account name, a red box will appear. Click on the red box.
4. You will see a message that says “(Someone) has invited you to a Hangout.”
5. Click Join Hangout.
6. The Hangout will automatically open. You will see your own image, and the images of the
other participants in the Hangout.

Useful Google Apps for Teaching and Learning
Centre for Development of Teaching and Learning

17

Starting a Google Hangout

1. Go to http://plus.google.com.
2. Sign in using your Gmail username and password
3. Click the Hangouts button on the upper right portion of your screen.

4. Click on Start a video party and then choose Start a party.

5. Enter a topic and start inviting the people to join you and then click Share.
6. The people you invited will receive an email invitation asking them to join the session.
7. Pictures of people who joined will start to display on the lower right side of the screen. You
can click on each thumbnail to check on them.

Useful Google Apps for Teaching and Learning
Centre for Development of Teaching and Learning

18

Exploring Google Hangout Tools

Once you have invited people to join you in the Hangout session, you can explore different tools to
start the discussion.
Group chat
Screen sharing
Capture
Special Effects
Scoot & Doodle
Google Drive

Sharing your screen with others in a video call
With the Screenshare feature, you can give other people the ability to see what is on your
computer screen. For example, if there's a picture open on your computer screen, other video call
participants can see it without having to download anything.
To share your screen:
1. Hover over the left side of the video call window, and a bar with various app icons appear.
2. Click Screenshare on the left side of your screen.
3. In the window that pops up, choose your desktop or choose the window that you want to
present.
4. Click Share Selected Window.

Collaborating on a Document
1. Hover over the left side of the video call window, and a bar with various app icons appear.
2. Click the Google Drive button on the left side of your screen.
3. If you upload a Google Doc that has not been shared with everyone in the video call, you will
be prompted to share it with the other participants so that they can see and edit it.
4. To access notes after a video call, simply sign in to your Google Account and go to
http://drive.google.com. From there you can browse for the doc or search for it.
5. Search for your Hangout Notes in Google Docs.
6. Your notes will be named Hangouts Notes: [date of Hangout] [time notes doc was created].
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Movenote

Movenote is a screencasting tool which allows you to create powerful webinars for students. You
can straight away record your lecture using the slides, pictures, or PDF from your local machine or
Google Drive. Similarly, students can record a presentation or an assignment explaining explicitly
the details. Once your recording is complete, the videos produced can be viewed on the web, or
using any mobile device such as smartphones or tablets. You also have the option to share the link
to social media, through email, or embed it on your class blog or website.

Recording Lecture Online using Movenote

To record a lecture video:
1. Open your browser and type in the URL: https://www.movenote.com.
2. Log-in using your Gmail account.
3. Click Add slides button and locate the file. The file can be from your local machine or it
could use the presentation file you have stored in your Google Drive.

4. Once the slides are loaded, make sure the system can detect your web camera and
5.
6.
7.
8.
9.

microphone.
To start narrating the slides, click the Record button.
You can pause anytime and resume when you want to continue.
When you finish narrating the slides, click Save and Preview.
Click the Playback button to review the recording you have done.
Click the Settings icon to edit the slides or click the Gmail Icon to share the link to your
students.

Share URL
to students
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